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Overview
iR-ETN/iR-ETN4O0R firmware supports EtherNet/IP protocol. In EasyRemote 10 software, the
description file (EDS) for EtherNet/IP devices can be generated. By scanning the iR-ETN/iR-ETN40R
devices in EasyRemote |0 software, the EDS file can be generated according to the current 1/0
configuration. The EDS file can then be imported by PLC or EtherNet/IP Scanner devices to complete
configuration with minimal effort.
® Applicable firmware version:

iR-ETN: V1.0.3.0

iR-ETN40R: V1.0.0.1
® Applicable EasyRemotelO version:

iR-ETN: V1.3.2.0 or later

iR-ETN40R: V1.4.3.0 or later
® For more information on updating iR-ETN firmware, please see
UMO19005E iR Series Firmware Update UserManual eng.pdf

This user manual explains how to generate iR-ETN’s/iR-ETN40R’s EtherNet/IP EDS File, and how to
connect PLC to iR-ETN/iR-ETN4OR via EtherNet/IP.

Chapterl. How to Generate EDS File using EasyRemotelO
For more information on EasyRemotelO, please see
UMO018004E EasyRemotelO UserManual eng.pdf

Step 1. Launch EasyRemotelO, click [Automatic scan] to scan network for iR-ETN/iR-ETN40R. The
information of iR-ETN/iR-ETN4OR and the connected modules is shown as below.

| Bl EasyRemotelo
. File Edit View Online Tools Help
‘E A BRDL o B 02 W iR s o9 °8

Project Window g X
10 Modules Address Map Parameter Power Information

~ B} iR-ETN (192.168.1.133)

il #1:iR-DI16-K Chanmnel Name Type Cinline Value Project Value
il #2:iR-DM15-P ~ iR-ETM (192.168.1.133)

#1:iR-DI6-K Dl

#2:iR-DM16-P DI/ DO 0=00

Step 2. Click [File] » [Export EtherNet/IP EDS] and select the file to export tags.

gl EasyRemotelO
File Edit Wiew Online Tools Helg
Open Ctrl+0
3 New Ctrl+M
H save Ctrl+5
"1_'1 Save As
Export Tag

Export PLCopenxXML
Export EtherMNet/IP EDS
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Step 3. Select the iR-ETN and click OK.

Export Tag Dialog

IR-ETM (192.1688.1.133)

EDS file is successfully exported.

EasyRemotelO

Users/larry'

iR-ETN EtherNetlP Connection Guide

Successfully export 1 file(s) 'IR-ETM (192.168.1.133).eds' in the folder 'C:/
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Chapter2. CODESYS
This chapter explains how to connect two iR-ETN and iR Remote I/O in CODESYS.

Step 1. In EasyRemotelO scan and export EtherNet/IP EDS.
EXERE F >

v [} iR-ETN (192.168.1.155)
il #1:iR-AI04-TR
il #2:iR-DQ16-N

v E} iR-ETN (192.168.1.161)
il #1:iR-AI04-TR
il #2:iR-DM16-P

Step 2. Open a new project in CODESYS and select a Weintek device.

Standard Project *

You are about to create a new standard project. This wizard will create the following
= objects within this project:
[E
- One pregrammable device as specified below
- A program PLC_PRG in the language specified below
- A cyclic task which calls PLC_PRG
- A reference to the newest version of the Standard library currently installed.

Device Weintek Built-n CODESYS (Weintek Labs., Inc.) ~

PLC_PRGin  Ladder Logic Diagram (LD} ~

b

Step 3. Click [Tools] » [Device Repository...].

® CODESYS_iR_ETM. project* - CODESYS

File Edit Wew Project Build Online Debug | Tools

el S (B Package Manager... b
m Library Repasitary. ..
Devi |ﬂj Device Repository... |

=5 copesys R Visualization Styles Repository. ..

= ﬁ Device (
B @l] PLC License Manager...

=..
W | Scripting 3

License Repository. ..

- o P

i
E Customize. ..
= [ Options...

T ERITTE r e TP =l

Step 4. Click [Install...].
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Step 5.

Step 6.

iR-ETN EtherNetlP Connection Guide

22 Device Repository

£

Location: | System Repository
{C:\ProgramData\CODESYS\Devices)

X

Edit Locations...

Installed deyice descriptions:

Mame Vendor  Version  Description

+ m Miscellaneous
+ m Fieldbusses
£ EHMI devices

+- [ pLcs

+ ? SoftMotion drives

E Install... i

Close

Select [EDS and DCF files (*.eds, *.dcf)] and then select the first *.eds file.

" Install Device Description

ped

T « EFE » lary » 3% » CODESYS » EIP v O EEEP »

ESEE - HEEHE
b EDE ~ =B EuEH
B Apple iPad [ iR-ETN (192.168.1.155).eds 2020/6/11 L5 09:26
¥ T [ iR-ETM (192.168.1.161).eds 2020/6/11 5 09:26
i
b=
W=
= EkR
- B
i, Windows8_05 1

— ATRIDA i hC

BEEZEN) iR-ETM (192.168.1.155).eds

v| EDS and DCF files (*.eds, * def v

L) HA

After importing the file, the iR-ETN is added under EtherNetIP Remote Adapter.

28 Device Repository

Location: | System Repository
{C:\ProgramData\CODESYS\Devices)

X

w Edit Locations...

Installed device descriptions:

Mame Vendar
=+ == EtherNet/IP Remote Adapter
m EtherMetlP Adapter 35 - Smart Software Solutions GmbH
m Generic EtherNet/IP device 35 - Smart Software Solutions GmbH
m Generic EtherMNet/IP device 35 - Smart Software Solutions GmbH
£l e | weintek Labs. , Inc.
+ - = FtherMet{TP Sranner

<

~ Install...
Uninstall

Bxport..

= &% C:\Users\arry\Documents\CODESYS\EIPYR-ETN (192, 168, 1, 155).eds
¥ Device R-ETN" installed to device repository.

Details..

Close
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Step 7. Add an Ethernet device.

m Add Device

iR-ETN EtherNetlP Connection Guide

Name: |Eﬂ’\emet

Action:
@® Append device

evice () Plug device () Update device

[Enter a string for a fulltext search in all devices... | Vendor: | <all vendors>

Name Vendor Version  Description
= [ Miscelaneous
Ei Ethernet 35 - Smart Software Solutions GmbH 3.5.15.0 Ethernet Link.
Ei iBus Weintek Labs., Inc. 1.0.0.0 cMT-CTRL local fieldbus to iR Modules
= [0 Fieldbusses
+--€AN CANbus

- b EtherCAT
+ - HB Ethernet Adapter
= & EtherNet/IP
=- HB Ethernet Adapter

@ 35 - Smart Software Solutions GmbH 3.5.10.0 EthernetLink.

m Ethernet 35 - Smart Software Solutions GmbH 3.5.11.0 Ethernet Link.

m Ethernet 35 - Smart Software Solutions GmbH 3.5.15.0 Ethernet Link.
- = EtherNel/IP Scanner

+ - w Modbus

+- H¥ Profibus
+ . H¥ profinet 10
*- 8§ sercos

Group by category Display all versions(for experts only) [] Display outdated versions

m Name: Ethernet
Vendor: 35 - Smart Software Solutions GmbH
Categories: Ethernet Adapter, Ethernet Adapter, Ethernet Adapter
Version: 3.5.10.0
Order Humber: -
Description: Ethernet Link.

=

Append selected device as last child of
Device

&  (You can select another target node in the navigator while this window is open.)

Add Device Close

Step 8.  Assign an interface (Ethernet).

[f] Ethernet x

General

Interface: | Pl

Status

Ethernet Device /0 Mapping

Information IP&ddress 152 .

—— Default Gateway 132 .

@ Use Qperating System Settings
O Change Operating System Settings

Subnet Mask 255 . 255 ., 252 . 0
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Metwork Adapters bt
Interfaces:
Wame Description IP Address ~

work Comnection 192.168.1.151

WiFi3 Realtek RTLE192CT Wireless LAN 802.11n USE 2.0 Network Adapter | 192.168.100.10

(&g EER* 10 | Microsoft Wi-Fi Direct Virtuel Adapter 00.0.0

iR * 11 | Microsoft Wi-Fi Ditect Virtuel Adapter #2 oono

IP &ddress 192 168 . 1 .151
Subnet Mask 355 0255 0252 . O
Diefanlt Gateway 192 1og . 1 254

MAC Address 44: 37 E6:CEFS 06

Step 9. Add an EtherNet/IP Scanner.

Caneel

Devices. T % X| [ Add Device
=45 copEsYs R_ETN -

= [ Device (CODESYS Control Win V3) Name: [EtherNet_TP_Scanner

= @U PLC Logic Adtion:

=} application
) Library Manager

@ Append device () Insert device

Plug device () Update device

[ pLc_PRG (PRG)

[Enter a string for a fultext search in all devices... | Vendar: | <Al vendors>

= (& Task Configuration
= g MainTask Name Vendor Version  Description

& PLC_PRG = [ Fieldbusses

[ Ethernet (Ethernet) = == EtherNet/IP

+-#8 Modbus
+  Profinet 10

[ EtherNet/iP Scanner
[ EtherNet/P Scanner

= <= EtherNet/IP Local Adapter
m EtherNet/IP Adapter
[ EtherNet/P Adapter
[ EtherNet/P Adapter
= &= EtherNet/IP Scanner
(6} 35 - Smart Software Solutions GmbH ~ 3.5.10.30  EtherNet/IP Scanner
35 - Smart Software Solutions GmbH 3.5.11.0 EtherNet/TP Scanner
35 - Smart Software Sclutions GmbH 3.5.15.20 EtherNet/IP Scanner

35 - Smart Software Solutions GmbH 3.5.10.20 A device that works as an EtherNet/IP Adapter.
35 - smart Software Solutions GmbH 3.5.11.0 A device that works as an EtherNet/IP Adapter.
35 - Smart Software Solutions GmbH 3.5.15.20 A device that works as an EtherMet/IP Adapter.

*Please note that [Auto-reestablish Connections] must be selected.

(1] EtherNet_IP_Scanner X

General

Options

EtherMet/IP Scanner If0 Mapping

I Auto-reestablish Connections I

Status

Information

Step 10. Add the first iR-ETN.

Devices - B X
= & copesYs R ETV -
=il Device (CODESYS Control Win v3)
= B pLciogic
=} Application

) Library Manager
BF PLc_PrG (PRE)
={#8 Task Configuration
= & ENIPScamnerIOTask
& EtherNet_IP_Scanner.10Cydle
= £ ENIPScamnerServiceTask
@) EtherNet_IP_Scarner.ServiceCy:
= 22 MairTask
8] pLcprG
= [ Ethernet (Ethernet)
[ EtherNet_IP_Scanner (EtherNet/IP Scanner)

[ Add Device

Name: [R_ETN

Actian:
@ Appenddevice () Insert device

ce () Update device

Enter @ string for a fulltext search in al devices.

. ‘ Vendor: | <All vendors>

Name
= [ Fieidbusses
= EtherNet/IP
= <= EtherNet/IP Remote Adapter
ﬁ] EtherNetlP Adapter
(i Generic EtherNet/PP device
EF[REM

Vendor Ve

35 - Smart Software Solutions GmbH  Ma
35 - Smart Software Solutions GmbH 3.1
Weintek Labs., Inc. Ma
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Start from step 3 again to add the second iR-ETN’s *.eds file. This will overwrite the *.eds file of the
first iR-ETN.
Add the second iR-ETN.

= ﬂj Ethernet (Ethernet)
= ﬁ EtherMet_IP_Scanner (EtherMNet/IP Scanner)
E} ir_ETM_155 (R-ETM)
E} iR _ETM_151 (R-ETN)

Step 11. The default iR module setting is shown. Add new parameters in User-Defined Parameters
tab.

® CODESYS_R_ETN_20200611 project* - CODESYS - o x

Fle Edt Vew Project Buld Onine Debug Toos Window Help

e s L - O i &% < w
Devices -7 X £l R_ETH_155 x -
=3 copesys R ETN_20200611 -
=" (@ Device (CODESYS Control Win v3) General -
=8 rcLoge Line Name Value Bitlength  Abortifemor  Jumptolineiferor Nextline Comment
= O Application Connections 1 slot 1 AID4 TR 4 Celsius / Fafrenheit Setting.  Celsius 16 o O [
@on

‘Assemblies
i ra——

il POUPRG) fined Paramaters
= @ Task Configuraton

= & BPscamertOTesk EtherNet/IP /0 Mapping
&) Etherniet_IP_Scanner.[oCyde

= & ENPScarerServiceTsk Status
&) Ethertet_IP_Scanner. ServiceC)

= & vanTask Information

8 rou
= (@ ethernet Etnernet)
= (@ Ethertiet IP _Scanner (EtherNet/Jp Scamer)

£} R_EM_155 REM) \
B} R_E™_161 (RETN) Move Up Move Down New.. Delete... Edit..

2 S Lastbuld: @ 0 ® 0 Precompile: o/ Current user: (nobody) @
| Select Parameters X

Name Class Instance  Attribute  Type Minimum  Ma: ™

slot 1 AI04_TR ch#0 Input Scale Range Lower Limit 112 1 8 INT -32758

slot 1 AID4_TR ch#1 Input Scale Range Lower Limit 112 1 g INT -32768

slot 1 AI04_TR ch#2 Input Scale Range Lower Limit 112 1 0 INT -32768

slot 1 AI04_TR ch#3 Input Scale Range Lower Limit 112 1 11 INT -32768

slot 1 AID4_TR ch#0 input Filter Frame Size 112 1 12 INT 0

slot 1 AID4_TR ch#1input Filter Frame Size 112 1 13 INT 0

slot 1 AID4_TR ch#2 input Filter Frame Size 112 1 14 INT 0

slot 1 AID4_TR ch#3 input Filter Frame Size 112 1 15 INT 0

slot 1 AID4_TR 4 Celsius / Fahrenheit Setting 112 1 19 INT 0

slot 1 AID4_TR ch#0 Temperature Offset 112 1 20 INT -32768

slot 1 AID4_TR ch#1 Temperature Offset 112 1 21 INT -32768

slot 1 AI04_TR ch#2 Temperature Offset 112 1 22 INT -32758

slot 1 AI04_TR ch#3 Temperature Offset 112 i 23 INT -32788 v
z P P P -

Show Parameter Groups [] Generic Parameter

Name: slot 1 AI04_TR 4 Celsius / Fahrenheit Setting

Class: 11215 Datatype: | INT
Instance: = Bitlength: 16 2
Attribute: 19 2 value: Celsius v

The initial values can be set after adding new parameters.
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E} iR_ETH_155 x

General

Connections

Assemblies

User-Defined Parameters

EtherNetfIP /O Mapping

Status

Information

Step 12.

Line Mame Walue Bitlength ~ Abortiferror  Jumptaolineiferror  Nextline
1 slot 1 AI04_TR 4 Celsius { Fahrenheit Setting 16 (] (] 0

In EtherNet/IP 1/O Mapping tab find the |0 address and start editing the program.

El iR_ETN_155 x

General

Connections

Assemblies

User-Defined Parameters

EtherNet(IP /O Mapping

Status

Information

Find Filter Show all -

Variable Mapping  Channel Address Type Unit  Description

oy slot 1 AI04-TR ch#0 %O INT New Help String
+ slot 1 AID4-TR ch#1 IWL INT New Help String
e slot 1 AI0S-TR ch#2 IW2 INT New Help String
T4 slot 1 AI0S-TR ch#3 %IW3 INT New Help String
+-"g slot 2 DQ 16N DO QW0 WORD New Help String
+ Fg slot 1 AID4_TR 4 Celsius / Fahrenheit Setting %OW1 INT New Help String

Guide
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Chapter3. Rockwell CompactLogix/ControlLogix

3.1. Adding a Single iR-ETN

Rockwell CompactLogix and ControlLogix can be edited using RSLogix 5000.
Step 1. Open [Tools] » [EDS Wizard] and import iR-ETN’s EDS file.

i RSLogix 5000 - RockWellL.23E [1769-L23E-QB1 20.12]
IHE SRE EEY FEQ ERL ESO00|Ssom Hmm

EEH S sbe o[ | HO- a
~ @ P =
B 0. I rmw — o E
v L B L.
Tt ».| F ok P 2 :
e 2 - SAD 3
| _ FHE |
BN < EDStWizard
..... izah ) r
""" EER SR
Cugtom Tools .
- [% ACwlePmgram Bl ContolFLASH
=15 WMain Task
Import EDS file following the on-screen instructions.
Eockwell Antomation’s EDS Wizard |z|

Welcome to Rockwell
= Automation's EDS Wizard

- The EDZE Wizard allows wou to:

- register EDV-based devices.

- e gister a device.

- change the graphic images associated with a dewvice.
- create an EDE file from an woluown device.

- upload EDE fileiz) stored in a device.

To continve click Next

FT—#w-| B |




D WE!NTEK

Rockwell Antomation’s EDS Wizand

Optons
That tazk do you want to complete?

(o Hegizter an EDE file(z).
This option will add & device(s) o our databaze

(7 Thiregister a dewice.
Thiz option will remove a device that has been registered by an EDE file from
our database.

™ Create an EDE file.
Thiz option creates a new ED file that allows onr software o recognize your
device.
(=
=

iR-ETN EtherNetlP Connection Guide

Rockwell Antomation’s EDS Wizand

Remstration
Electronic Diata Sheet file(z) will be added o wour svsterm for vse in Rockwell
Automation applications.

(* Fegizer a single file

(" Register a directory of EDS files -

Wamed:
|C:".Dcucmnents and Settingsid 4w DocwmentsiF-ETHN (192.168.1.133) &

*If there iz an dcon file (dco) with the same name as the file(z) yon are registering
then this image will be asmociated with the dewvice.

To perform an installation fest on the file(z), click Mext

< F—#E | TF—FHW- R

10
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Eockwell Automation’s EDS Wizard

EDZ File Installation Test Results

Thiz test evaluates each EDS file for ervors in the EDE file. This test does not
guarantee EDE file walidity.

- '] Installatinn Test Results
E| chdocnments and settingswd v docomentsic-etn (1921631 1330 2dz

View file...

Rockwell Antomation’s EDS Wizard

Change Graphic Image
Vo can change the graphic image that is associated weith a device.

Product Types
Change icoi... = @ Comumumcations LAdapter

iH-ETH

2@ | [F=HNE]

11
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Step 2.

Eockwell Automation’s EDS Wizard

Final Task Summary
Thiz iz a rewiew of the tagk wou want fo complete.

=¥ on wonld like to register the following device.

iR-ETH

t—#@| [FT-Hw-| @w |

Rockwell Automation’s EDS Wizard @

© You have successfully completed the EDS Wizard.

Right-click on [Ethernet] and select [Add Module...].

12
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it RSLogix 5000 - RockWellL23E [1769-L23E-QB

FiHE REE BEREIM HEED EEL BEC

Bl 0. I rw e
FaEH p.| oK 1}’
Fimta [T BAT

=| [T I/0 @

Controller E3E 35

=50 FEHI8R RockWellL23E
S EHIERTE
[0 =4 8edse 1988
[T fnep /3888
=51 1S
=58 CyweleTask
Eﬂ; ACyleProgram
=& MainTask
Eﬂ; MadnProgram
[T S EIeeE FaE
= i=E0EA
[T a2
(3 4dd-on BEXIES
=55 g
L ApEs
L e
L £dd-On-Defined
L FAmES
L iEERTEs
3 gam
=51 A I ECE
= Compactlogixi323E-QB1 Fif
§0 1769-L23E-QB1 RockWellL22E
-4 1769-L23E-QB1 Ethemet Port Locall

&5
=80 Compacti) 7] AddModule...
=55 B
C M
C My
B
$TED »
3 : -
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Select Module Type

BE | Modulke 53 | Wdist |

e | [FeuEEc)

B5 fat HEEE Ecill|

Weintek Labs, [ Commumnications: Ldap

£ | >
1 #211 Module 2580 B33
[] BlzRE (L) [(meE | [ =m | [ == |

Enter iR-ETN’s IP address and device name. The device name will be used in the tags.

W 3k Module g|
Bl |3§}§ " Module {58 " Internet FHH " ﬁDEEE|
Eachii iE-ETH. x iR-ETH
HERETR Weintek Labz., Inc.
ART LocalEHE
EH M) |ETH] | 1207 Pt
1HBR () £ @ EHAFE E): 1921681 H
OTe itk @: | |
Oxfzw: | |
Nodule FEX
W 1.1
METFEHE T 3E Module
LR Ezdusive Cumex
e RO [ ®mE | [ B#E© | [ Kb

Step 3. iR-ETN’s Input/Output Data can be found in the tag.
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#/ RSLogix 5000 - RockWellL23E [1769-L23E-QB1 20.12]* - [Controller Tag - RockWellL23E (controller)]

A zpp 88O ZE@ BT BR0 BE0 T8O S000 ¥

a=HE &

v &8 G |E ¥ v
;:;ﬂ E. IIZSKU'N L@E ﬁﬂ B4 : [AB_ETKIP-11192 165 1_ 158" Backpl anai0* = E
Exery 2; [T BAT
= 10 i r
NS i O G e
I B[ == ®) | fORockhel1123F v EF@: FH Tag w7
T a*iii.j‘;g;f;“gm | E= AL [#%#Tay  [DataTune [ e [sremni  |mg  [s
[ FE4I9B A RN TR SR |*ETHE _DB3CHA_ETMx 1A0FO524C:0 Read/wite O
(3 e 23 _FETHI _DG3C:R_ETNx_S8DESDOCD Read/wiite ]
5 ?%%Cyclﬂask ETM:|. ConnectionF aulted BOOL ReadMwrite Decimal
+ [:& ACyeleProgram | T ETH:l.Data SINT[E] ReadMwrite Decimal
=) @ MainTask + ETH: Datald] SINT Flead/wite Decimal
= @“‘;Er;i?‘;‘{ + ETN Datal1] SINT Read/wiits Decimal
o + ETH Diataf2] SINT Plead/wite Decimsl
01 ARz PR _l=Emo _OR3CHA_ETNx FATADOTAID Plead/wite O
T aémaiﬁia*m —/ETN:0.Data SINTH] Fead/wite Decimal
£3 Addon BEWIES + ETH:D Datalll] SINT Read/wite Decimal
Select the corresponding bit when programming.
| ETH B
. W | TS - B Tag “
| &% ~=| | Dt Type | i8R |~
ﬂ ¥ ETH:C _DEaCaE _ETH..
ﬂ ¥ ETN:I _O63CaR_ETH..
ﬂ — ETH:O _OA3CHE_ETH..
—) ETN:01 Diata SINT[1]
ﬂ ETHO Dt o0 | BINT
[of1]2]s[4]s]e]7]
W
[ Controller [C) ]
[ Frogram (B] ]
sbed | B b v cabr
ETh| Diata[n] 0 ETh:O Diata] 1
i} i
JC
ArrayBool[0] ETIM: O Data0] 1
1 JE
10
(3R

3.2. Adding Multiple iR-ETN

In Allen Bradley software, each device requires a unique EDS file. To add multiple iR-ETN (each with
different number of 1/0), please follow instructions below.

Step1. Go to [Ethernet] » [Add Module] and add Generic Ethernet Module.
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=0 offfine B. No Forces ). No Edts a "Favorites AddOn PlantPAx _ Safely Alams DR TimerCounter Inpul/Outpul _Compare  Comi
Controller Organizer v 3
o=
= Select Module Type
4 . Controller TWO_ETN_IO
@ Controller Tags Catalog Module Discovery Favorites
Controller Fault Handler
Power-Up Handler [ceneric Clear Fiters Fide Filters &
4 < Tasks
4 £3 MainTask Module Type Category Filters Module Type Vendor Filters -~
> & MainProgram 20-Comm-ER Advanced Energy Industies. Inc
Unscheduled [4] Analog Dialight
b # Motion Groups CIP Motion Safety Track Section Endress+Hauser
> i Alarm Manager Communication FANUC CORPORATION %
b Assets
1 Logical Model Catalog Number Description Vendor Category
4 211/0 Configuration ETHERNET-BRIDGE Generic EtherNet/IP CIP Bridge Rockwell Automation/..  Communication
4 88 5069 Backplane ETHERNET-MODULE Generic Ethermet Module Rockwell Automation/.._Communication
P ETHERNET-SAFETY-STAN... Generic EtherNetIP Safety and Standard Mo... Rockwell Automation/... ~ Safety.Other
£ (0] 5069-L306ERM TWO_ETN_IO
4 & A1, Ethernet
{5 5069-L306ERM TWO_ETN_IO
B} iR-ETN.x ETN_1
4 #5 A2, Ethernet
B 5069-L306ERM TWO_ETN_IO
Tt= Controller Organizer
30f 812 Module Types Found Addto Favorites
Close on Create Creste | | Close Hel
(@ OEwmors || 4 OWanmings || @  OMessages a P
Step 2. Configure connection parameters for iR-ETN’s EDS file.
= 2 T IR-ETN (192.168.1.212) - Notepad - O X
B8 Vew Seach logc Communkations Toos Window Help ) P
De W e X 79 Vi i Dby G [Assembly] ~
ST Revision =
17 pen o> AL At Object_Name = "Assembly Object”;
T SO orpine 1. Mo Forces b Nocdts 7 "Favorites TAGION PIaPAY s B TrerCamisr opaORpA CompesCan] Quiect Class Code - 0x04;
Assem100=
Controler Organizer it P———
] g
4 < Controller TWO_ETN_IO -
? Controller Tags Catslag  Module Discovery Favortes X00006,
Controler Faut Handler .
Power-Up Handler GENERIC ClearFiters: R TAG R 8,Param100,
- Tasks 16,Param101,
42> MainTask & mod 16,Param102,
*» h MainProgram & 2-¢ 16,Param1e3,
Unscheduled B Analt pyg ETHERNET MODULE Generic Enemethodue 16, Param104;
b 5 Motion Groups. EW" Verdor: Rockwe! Automation/AllenBradley Assem150= .
b 1 Alarm Manager B Com  parmet Local “output Assembly)
b Assets Nams: »
 Logical Model Coiogy Kbl Assembly / .
4 <110 Configuration ETHE| Description: o 0x0001,
« @85069 Backplane Enel rput w | [ e .
5 0] S063-L306ERM TWO_ETN_I0 £ S " T ] &,Paran200;
4 8 A1, Ethernet | ASSemiol =
£ 5063-L30SERM TWO_ETN_IO Coamn ot (S SE AD 21 consguaton: [151 0 2 "Config Assembly)
- Address [HostName
. Ornisem [ W @ T W | .
4 5 A2, Ethernet i ex0001,
5063-L306ERM TWO_ETNJO = s
8,parani,

[Z10pen Mok Properies o =y e 5ip s
8,Paramd,
8,Params,
8,Params,

3ot 812 Mote Types Found AddoFeraries 8,Parans;
- PR [Connection Manager]
@ OEron |[ 4 OWamings || @ OMessages L L Object Name = "Connection Manage
- Object_Class_Code = 0x06;
Connectionl =
0x84010002,
AVAARAAADS i

*When Assembly Instance only has Input, “Comm Format” must be set to

“Input Data — SINT”.

Type: ETHERNET-MODULE Generic Ethernet Module
Vendor: Rockwell Automation/Allen-Bradley
Parent Local
N . Connection Parameters
ame ETN
Assembly
Description: q Instance: Size:
Input: |100 ‘ ’10 (8-bit)
Output ’150 ‘
F - Input Data - SINT ~
Garma orm4 . Configuration: |‘51 ‘ \‘0 S (8-bit)
Address [ Host Name
@ IP Address: \ 192 . 168 . 1 6 | tus Input
(O HostName: AL
Open Module Properties 0K Cancel Help

Step 3.

Enter iR-ETN’s IP address, name, and description.
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¥ | Module Properties Report: Local (ETHERNET-MODULE 1.001) x _

4 < Controller TWO_ETN_IO
< Controller Tags
Controller Fault Handler
Power-Up Handler
4 Tasks
4 {» MainTask
b L MainProgram
Unscheduled

b % Motion Groups
b # Alarm Manager
b W Assets

" Logical Model
4 . 1/0 Configuration
4 895069 Backplane
{5 (0] 5069-L306ERM TWO_ETN_IO
4 5 A1, Ethernet
5 5069-L306ERM TWO_ETN_IO
9 ETHERNET-MODULE ETN_2
BF iR-ETN.X ETN_1
4 §5 A2, Ethernet
5 5069-L306ERM TWO_ETN_IO

Controller Organizer

Step 4.

General Connection Module Info

Type ETHERNET-MODULE Generic Ethernet Module
Vendor. Rockwell Automation/Allen-Bradley
Parent Local
N Connection Parameters
lame ETN_2
= Assembly
Description: | Instance: Size:
Input {100 9 (&b
| B
— 1] Output ‘ 150 | (8-bit
Fe Data - SINT e e B
San Configuration [15‘ 10 S (8bin
Address / HostName .
@ P Address 192 0168 . 1 14
(OHostName:
Status: Offine Cancel Apply Help

Enter RPI. Use the default setting, which is 10 ms (min. RPI support for iR-ETN is 5 ms).

& Logu Designer - TWO_ETN_KO in TWO_ETN_I0 - 2ACD (5069-L306ERM 33.11]*

D fle Edt View Search Logc Communcstons loos Window Help

vt eie xadalne v % i (D bt
= :
s I P crones NEon ‘
7o S offne 0. o Foreas . Hokdne a T avortes AGEDT PienFAY Sty A

i o I

Ganeral Connecton Moduls Irfo

4 Controller TWO_ETNJO
@ Contraller Tags
Contraller Fault Handller
Power-Up Handler
4 ATasks
4> MainTask
» b MainProgram
Unscheduled
b Motion Groups
b 85 Alarm Manager
b Assets
*» Logical Model
4 <10 Configuration
4 #5069 Backplane
{53 0) 5069-L30GERM TWO_ETN_ IO
43 A1, Ethemet
5 5069-L306ERM TWO_ETN IO
9 ETHERNET-MODULE ETN 2
i RETNX ETN_1
48 A2, Ethemet
1 5069-L306ERM TWO_ETN 10

Step 5.

RequesiedPacket nlenal (RP). | 100/:2ms  (10-32000ms)
[RETT
v

(£ Use Unicast Connecton over EtherNet®

Moduie Faut

Staus. Ofine Help

When you have finished setting the parameters, you can see iR-ETN’s I/O status in

Controller Tags page. In this example, the first slot of iR-ETN = DM16-P and the second

slot = Al04-TR.

& Logi Designer - TWO_ETN_IO in TWO_ETN_IO - 2ACD [5065-LIOGERM 33.111*

Fle Eit View Seach logic Communiatons Tods Window Hep
DL N8 xd 2 %% ek bt
= s

=k ] Path <nane> v &L

Scope: {5 TWO_ETNIO Show A8 T,

4 « Controller TWO_FTN_JO

Controtler Tags Mevrend
Controller Fault Handler « ETN2O
Power-Up Handles » EIN.20Data
P
4 O>Mainlask < ETN2
> & MainProgram » EIN 240010
Unscheduied
» ETN
» ™ Motion Groups 2C
> 8 Alaem Manager » EINIO
> - Assets > EINT

\ Logical Mode!
= VO Configuration
+ 85069 Backplane
£5 (0] 5069-L306ERM TWO_ETN IO
4 & A1, Erhemet
5 5069-L306ERM TWO_ETN IO
8 ETHERNET-MODULE ETN.2
#RETNXETN 1
4% A2, Eemet
D 5069-L306ERM TWO_ETN IO

b emac (] (X

Titps Compare

- oo e 5o (e ]
{5} A] ABETHERNET_MODULE_SINT_1Bytes00 2204 /N 1. | Extended Properti v
(8] SINTIT] 4 Sy, el
(5] (A ABETHERNET_MODULE SINT_9Bytes:0 e

Description
(5} () Deamel  SINTI9) Usage
%] ABETHERNET_MODULECD Type
(] 063CR ETNX 61€59225:00 Ao
Base Tag
(%] _O63CiR _ETNx 3HD7ESALD e
_063CHR ETNx COCE3970CO Scope

External Access
Style
Constant

Alarms 0
+ Data
Valve
Force Mask
» Produced Connection v

+ & \ Monitor Tags / Fai Tags /

OEmos || 4 OWamings |©  OMessages

[l © Type here to search

& 67°F Mostly doudy

17
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Chapter4. Panasonic FP7

Panasonic FP7 CPS41E CPU supports EtherNet/IP, please use Control FPWIN Pro 7 software to edit
the program.

Step 1. Use static IP for PLC.

W3 FP7_CPS41E.pro - Control FPWIN Pro 7 - The IEC 61131-3 programming system - [P addresses
Project Object Edit Online Monitor Debug Extras Window Help

EH e

_J|

Project variables
il | e L] Us ltem name
@ Project [D:\ProjectPLC\Panasonic\FPWIN_Pro\FP7_Cff (846 | Lis= [Pud addiess
v g PLC (FP7 CPS41E) 847 Aut i Disable
~ » Systemregisters 857 192.168.1.43
& Memorysize 859 255.255.252.0
& Hold en/off 861 192.168.1.254 -
/‘15 Acton errar 246 "Yes
& Timelnut 847 "Disable
v Serial ports
#° Como 881 e o
_}b COM1 873 4to0 128
#° comz £97
v @ Ethernet 22 - Disable
@ IP addresses S
Time synchranization 933 Alternate DNS 5
Ea Web server
HTTP client
FTP server

Step 2. Open EtherNet/IP Setting » [EDS File] » [Register...] and import iR-ETN’s EDS file.

W FP7_CPS41Epro - Control FPWIN Pro 7 - The [EC 61131-3 programming system - Program_1
Project Object Edit Tools Online Monitor Debug Extras Window Help
SHE T o8 9% 8 | @
Project
Fo e | @2 U S
@] Project [D:\ProjectPLC\Panasonic\FPWIN_Pro\FP7_(]
v @ PLC (FP7 CPS41E) = H'

~ # System registers Scan List Delete P
#7 Memory size w Edit Comment...
#° Hold onfoff Whole
/’5 At I/OMap - S addto Sean List
‘ ;b onerer o Scanlist-U Init L

3

& —_1__"|| 9 o

. EtherMet/IP Setting
File Edit View EDSFile Setting Help

Beagister...

Timeout Device Property...

- Serial ports
_,5 COMD Import Device Data Base...

F° Com1 Export Device Data Base...
&7 comz
v @ Ethemet
@ IP addresses
Time synchronization
B Web server
HTTP client
FTP server
FTP client
SMTP client
& System connections (4 system connes
User connections (16 user connection
&_ EtherMet/IP (1 connection)
Routing
@? TCP time settings

L T (PR

Step 3. Right-click on iR-ETN and select [Add to Scan List].

w




DVWE!NTEK iR-ETN EtherNetlP Connection Guide

Device List o
By Wendor By Device
Device Mame Device Type 2

FP7CPU UMIT AFPTCPS41E Communications Ac

FRTCPU UMIT AFPTCPS31... Communications Ac

FE7CPU UNIT AFFTCPS41... Communications Ac

FPOH COMTROL UMIT AF... Communications Ac

w
Register EDS File...

< Delete EDS File

Save Setting| | Read Se Edit EDS File Comment...

Add to Scan List

Device Property...

Import Device Data Base...

Export Device Data Base...

Scan List a
. FP7 CPS41E(192.168.1.43) Usakle Connections:
----- I/ Map - Scheduled Connections: 0
EI Scan List - Use Connections: 1
= M (1] R-ETN (192.168.1.44)

Exlusive Cwner

Step 4. [Setting] » [EtherNet/IP Basic Configuration...]

Wl Ctherblet/IP Setting

File Edit View EDS File @ Setting Help

= Hl ¥ oGy @ Etherklet/IP Basic Configuration... '

S0 P

Set [Auto Allocation] to “No”.

19
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EtherMet/IP Basic Configuration x
Auto Allocation
LD Device Starting No. (Setting Range: 0 to 16383) ]
Refresh Unit (Setting Range: 0 to 65535) 252 Word
RUM/IDLE bit operation of cydic communication Mormal v
Cydic Communication Start Timing Auto ~
Cydic Communication Node Connection Wait Time (Setting Range: 1 to 300 s) |GD | 5
Cydic Communication Connection Automatic Reconnection Wait Time (Setting Range: 1to 120 s) | 5 | 5
Message Communication Timeout (Setting Range: 10 to 65530 ms) | 10000 | me
Connection Timeout (Setting range: 1to 10s) | 1 | g
TTL for Multicast (Setting Range: 1 to 255) E |
Multicast Address Setting Method Auto v
Mo, of Multicast Addresses (Setting Range: 1 to 258) 256
Multicast Starting IP Address 239 .255. 0 . 0
IGMP Query Send Enable Invalid w
IGMP Query Transmission Interval (Setting Range: 1 to 18000 5) a0 5
Cancel
Step 5. Device Allocation is currently empty.
Wl EtherNet/IP Setting b
File Edit View EDSFile Setting Help
FH| ¥ =Y
Scan List ® | W « » M /Connection Setting ' Device Property % Device Sefting
Bl FP7 CPS41E(192.168.1.43) Usable Connections oo Pl
/O Map - Scheduled Connections: 0
B Scan List - Use Connections: 1 Node Name iR-ETN Device Mame iR-ETN
- [1] IRETN (192.168.1.44) Gonnection Name vl G B oolcation Tops Exclusive Owner
Compatibility Check. Follow Adapter Rule ~ GOS Transmission Disable ms
Gommunication Method Instance Timeout Period RPIx 4 ~
Tnput Send Trigzer Gyelic Parameter Setting (Tnput:200ms # Output: 200ms)
Input Information (T>0)
RPI(10.0ta 1000ms) me Device Allocation
Connection Type Faint to Point v Starting Devi Size Offset - Add
Thstance ID 100 !
2 Edit
Data Size 1 WWord 3
Refresh Method Batch = M v Delete
Total Data Size: 0 YWord Remaining Data Sizes 1 Word
< > Output Information (0>T)
Device List o
RPI (100t 1000ms) ms Device Allocation
By Vendor By Device
Tstance 1D 160 Starting Devi Size Offset " Add
Device Name Device Type ~ .
FP7CPU UNIT AFP7CPS41E Communications Ac Do 8 ! e 2 Gl
FP7CPU UNIT AFP7CPS31.. Communications Ac Refresh Method Batch w 3
FP7CPU UNIT AFP7TCPS41... Communications Ac + v Delete
FPOH CONTROL UNIT AF__ Communications Ac Total Data Size: 0 Word Remaining Data Size: 1 Word
iR-ETN Communications Ac
v
< >
Read Settine ok Gancel

Right-click on iR-ETN and select [Reallocate Device].
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Scan List L N P

. FP7 CPS41E(192.168.1.43) Usakle Connections:
----- I/ Map - Scheduled Connections: 0

EI Scan List - Use Connections: 1 Mo

Exlusive Cwne Add Connection

Va

Delete
Delete All

Rearrange Scan List

Reallocate Device

=3 Copy

£ cut

Settings can be saved for other projects to read by clicking [Save Setting].
Click [OK] to finish settings.

Step 6. Configure I/O mapping in [Global variables] tab for use in the program

#F Global variables X

Class Identifier FP address |IEC address Type Initial
o] VAR_GLOBAL bT1 LD0.0 2eMX8.0.0 BOOL FALSE
1 VAR_GLOBAL  bOuti LD1.0 96MX8.1.0 BOOL FALSE
2 VAR_GLOBAL  bOut2 LD1.8 hMXB.1.8 BOOL FALSE
3 VAR_GLOBAL bT2 LD0.3 FehMX8.0.8 BOOL FALSE
- ferm = == I
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Chapter5. KEYENCE KV Series

KEYENCE KV-NC32 can connect to iR-ETN using KV-NC1EP. Use KV STUDIO software to edit the

program.

Step 1. Open anew project, double-click on KV-NC32, and then add KV-NC1EP in Unit Editor.

== Unit Editor - Edit mode — [} s
File(® Edit(E) Convert(®) View(d) Option(Q) Window(\) HelpH)

@ | e il O |8 E A= @

Unit 1

Select unit(1) | Setup unit(2)

Width: 44mm

Height : 90mm A
Bl Tenperature input unit A
B xv-ncate ich Temperatur
Ei Network unit
E EV-NC1EP EtherNet/IP unit
v
EV-HC1ZP

EtherNet/IP scanner (100BASE-TX: Single
channel)

Step 2. Set the IP address of KV-NC1EP.

E Base
Leading DM No. DH10000
Number of DMs._ _. 230
Leading relay... R100a0
Number of rel. . 40
Baud rate 100/10Mbps aut. ..
Setting metho. .. Fixed IP addre. ..
IF address 1%2.1€8.0.10
Subnet mask 255.255.255.0

Default gateway og.0.0.0

DNS server 0.0.0.0
Receive timeo. .. 1a
Feep Aliwvel[s] €00

Step 3. EtherNet/IP setting of KV-NC1EP:

El EtherNet/IP settings

Zutomatic distribution setup Enable(*)
Start No. of the distribution bit device

Start No. of the distribution word device

Update upper limit [word/scan] 252
cyclic(If0) messages starts automatically Enable(*)
cyclic(If0) messages error detection mask time (when connect... &0
cyclic(If0) messages error detection mask time (when disconn... 5
Explicit messages timecut [ms] 1000a
Retry time (system expansion) [s] €0
Multicast TIL 1
Multicast address designation method Automatic distribution(*)
Humber o dress 25¢

Multicast initial ress 235.255.0.0

Enable IGMP query sending Disable(*)

<Setting>
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Step 4. ImportiR-ETN’s EDS file generated by EasyRemotelO.

B, EtherMet/IP settings

File(E) Edit(E) Settings(S) Viewd) Convert(C) EDSﬁIe@|Cnmmunicatinn(ﬂ)

- @D & % B9 . @E Regl-

Delete(D) |
V—HNC > . 68 .0 [ - i
EV-NC1EP[1] - 2. ULl SE'EII'IIhlé,I...
Edit comments(E)... E
B = X
mweweq | T v @ @# @
SFEM) Al
piEER 1
=]
B RETN |
" (192.168.0.11).ed:
Q BER (1) -~
i
&%
OS_cMT-FHD._...
HEAE® “
v
BREWW:  |R-ETN (1921680 11)sds ~] IO

THFEARRY(T: EDS file (*eds; *ezl) v KK

Step 5. Double-click on iR-ETN to add it into the settings and then set iR-ETN’s IP address.

E; Etherhlet/IP settings — O >
File(Bl Edit(E) Settings(S8) View(N) Convert(C) EDSfile(D) Communication(M) Toold Help(H)
+ (D E LY cOay hEl @

EtherMet/IP unit n
EV-NCIEP[1] : 192.168.0.10

Unit list(1) Unit setting(2) | Search unit(3)
5 i | B BI—
WG| TE = | E
Unit name Rev. |EDS fil... |~
1l: iR-ETN : 68.0. EH SZ2-V S5Z-V Se...

EH WI-5000 Series WI-5000...
[ XG-8000/7000 XG-8000...

1.1
1.1
1.2

Initial adapter settings [ XG-X1000 Series 1.1 %G-X100...
1.1
1.1

Mode address(A)

IP address(l) | 192 . 168 . 0 . 1 |

EH XG-X2000 Series XG-X200...
EH Generic Device Generic...
intek Labs., Inc.

B iR-TH iR-ETN v

>

Connection name 1o
Exlusive Owner B ot

iR-ETN configuration is completed, the input address is W00 and output address is W02.




,__| WE!NTEK iR-ETN EtherNetIP Connection Guide

EV-NC1EP[1] : 182.168.0.10

iR-ETN : 182.168.0.11

B Exlusive Owner

OUT 150

Step 6. Click [Apply] to finish.

#, Etherhlet/IP settings

File(B) | Edit() Settings(S) Vil
(D Auto configuration(s)
B import())... Ctrl+K

[: Apply(A) Ctrl+5 |

o Close(C) Alt+F4

Input module corresponds to W00 and Output module corresponds to W02. Edit the PLC program,

download the program to PLC and then run the program.

CODESYS @ is a trademark of CODESYS GmbH.

Other company names, product names, or trademarks in this document are the trademarks or registered trademarks of their respective companies.
This document is subject to change without prior notice.

Copyright© 2023 WEINTEK 10T LTD. All rights reserved.
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